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  Tutorial: Introduction to ENVI 

Overview of This Tutorial 
This tutorial is designed to introduce you to the basic concepts of the ENVI software and some of its key features. It 
assumes that you are already familiar with general image-processing concepts. 
 
In order to run this tutorial, you must have ENVI installed on your computer. 
 

Files Used in This Tutorial 
ENVI Resource DVD: envidata\can_tm 
 

File Description 
can_tmr.img Cañon City, CO, TM Data 
can_tmr.hdr ENVI Header for Above 

Getting Started with ENVI 
Starting ENVI 
Before attempting to start the program, ensure that ENVI is properly installed as described in the Installation Guide that 
shipped with your software. 

Starting ENVI on Windows Machines 
• Select Start  Programs  ENVI x.x  ENVI. 

(where x.x is the version number) 

Starting ENVI in UNIX 
• For ENVI, enter envi_rt at the UNIX command line.  
• For ENVI+IDL, enter envi at the UNIX command line.  

Starting ENVI on Macintosh Machines 
1. Display an OSX, UNIX X-window. 
2. Do either of the following: 

• For ENVI, type envi_rt at the UNIX command prompt. 
• For ENVI +IDL, type envi at the UNIX command prompt. 

Loading a Gray Scale Image 
Open a multispectral Landsat Thematic Mapper (TM) data file representing Cañon City, 
Colorado, USA. 

Opening an Image File 
1. From the ENVI main menu bar, select File  Open Image File. 
2. Navigate to the envidata\can_tm directory, select the file can_tmr.img 

from the list, and click Open. 

The Available Bands List 
ENVI provides access to both image files and to the individual spectral bands in these 
files. The Available Bands List is a special ENVI dialog containing a list of all the a
image bands in all open files, as well as any associated map information.  You can use 
the Available Bands List to load both color and gray scale images into a display. 

vailable 

 
The File menu at the top of the Available Bands List dialog provides access to file 
opening and closing, file information, and canceling the Available Bands List. The Options menu provides a way to find 
the band closest to a specific wavelength, shows the currently displayed bands, allows toggling between full and 
shortened band names in the list, and provides the capability to fold all of the bands in a single open image into just the 
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image name. Folding and unfolding the bands into single image names or lists of bands can also be accomplished by 
clicking on the + (plus) or – (minus) symbols to the left of the filename in the Available Bands List. 
Right-clicking in the Available Bands List displays a menu with access to different functions. The right-click menu 
selections will differ depending on what item is currently selected in the Available Bands List. 

1. Select TM Band 4.  The band you have chosen is displayed in the field marked Selected Band. 
2. Click the Gray Scale radio button then click Load Band to load the image into a new display.  Band 4 will be 

loaded as a gray scale image. 
 

ENVI File Formats 
ENVI uses a generalized raster data format consisting of a simple flat-binary file and a small associated ASCII (text) 
header file. This file format permits ENVI to use nearly any image file, including those that contain their own embedded 
header information.  ENVI also supports a variety of data types: byte, integer, unsigned integer, long integer, unsigned 
long integer, floating-point, double-precision floating-point, complex, double-precision complex, 64-bit integer, and 
unsigned 64-bit integer. 
 
Generalized raster data are stored as a binary stream of bytes in either Band Sequential (BSQ), Band Interleaved by 
Pixel (BIP), or Band Interleaved by Line (BIL) format. 

• BSQ is the simplest format, with each line of data followed immediately by the next line of the same spectral 
band. BSQ format is optimal for spatial (x,y) access to any part of a single spectral band. 

• BIP format provides optimal spectral processing performance. Images stored in BIP format have the first pixel 
for all bands in sequential order, followed by the second pixel for all bands, followed by the third pixel for all 
bands, etc., interleaved up to the number of pixels. This format provides optimum performance for spectral (z) 
access of the image data. 

• BIL format provides a compromise in performance between spatial and spectral processing and is the 
recommended file format for most ENVI processing tasks. Images stored in BIL format have the first line of the 
first band followed by the first line of the second band, followed by the first line of the third band, interleaved up 
to the number of bands. Subsequent lines for each band are interleaved in similar fashion. 

Exploring the ENVI Header File 
The separate text header file provides information to ENVI about the dimensions of the image, any embedded header 
that may be present, the data format, and other pertinent information. The header file is normally created (sometimes 
with your input) the first time a particular data file is read by ENVI.  It can also be created outside of ENVI using a text 
editor. 

1. From the ENVI main menu bar, select File  Edit ENVI Header. 

2. Click once on can_tmr.img to view the ENVI header file for this image. 

3. Click the Cancel button to close the header file. 

4. Right-click on an image name in the Available Bands List and select Edit Header as an alternate way to view the 
ENVI header file. Close the header file. 
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ENVI Windows and Displays 

The ENVI Main Menu Bar 
In ENVI, activities are initiated by using the menus in the ENVI main menu bar, which may be oriented horizontally as 
shown below, or vertically (as set via the option on the File  Preferences  Miscellaneous tab). 

 

The Display Group 
As you work with ENVI, a group of windows will appear on your screen allowing you to manipulate and analyze your 
image. This group of windows is collectively referred to as the “display group” and the default setup consists of an Image 
window, a Scroll window, and a Zoom window. 

 

Image window 

Zoom Window Scroll Window 

You can choose which combinations of windows appear on the screen by right-clicking on any image window to display 
the right-click menu and selecting a style from the Display Window Style submenu.  Use the ENVI main menu bar 
File  Preferences  Display Defaults tab to change the default settings for which windows you wish to display and 
where you wish to position them. 
 
You may have many display groups open on the screen at any time. A wide variety of other types of ENVI windows may 
also be displayed, such as scatter plots, spectral profiles, spectral plots, and vector windows. 
 
All windows can be resized by grabbing and dragging a window corner with the left mouse button. 

1. Resize the Image window to be as large as possible (until the Scroll window disappears). 
2. Now, make the Image window smaller than the full extent of the image data (the Scroll window will reappear). 
3. Resize the Zoom window and notice how the outlining box changes in the Image window. 
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The Image Window 
The Image window shows a portion of the image at full resolution. 

 

Display Group Menu Bar 

Zoom Box 

The Display group menu bar provides access to many ENVI features related to the images in the display group.  By 
default, it appears at the top of the Image window.  If you have chosen to display only the Scroll and Zoom windows or 
just the Zoom window, the menu bar will appear at the top of the Zoom window. 
 
The Zoom box (the colored box in the Image window) indicates the region that is displayed in the Zoom window. 

1. Place the mouse cursor in the Zoom box in the Image window, hold down the left mouse button, and move the 
mouse. The Zoom window is updated automatically when the mouse button is released. 

2. Place the cursor anywhere in the Image window (outside of the Zoom box) and click the left mouse button to 
move the magnified area instantly. If you click, hold, and drag the left mouse button in this fashion, the Zoom 
window is updated as you drag. 

3. Click once in the Zoom box in the Image window and use the arrow keys on your keyboard to move the box. To 
move several pixels at a time, hold down the Shift key while using the arrow keys. 

 
You can choose to have scroll bars displayed in the Image window.  These scroll bars provide a way to move through the 
Scroll window, allowing you to select which portion of the image appears in the Image window. 

1. Right-click in the Image window and select Toggle  Display Scroll Bars. 

2. To have scroll bars appear in the Image window by default, use the ENVI main menu bar to select the File  
Preferences  Display Defaults tab.  Set the Image Window Scroll Bars toggle to Yes.  
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The Scroll Window 
The Scroll window displays the entire image at reduced resolution (subsampled). The subsampling factor is listed in 
parentheses in the window Title Bar at the top of the image. The highlighted Image box (red by default) indicates the 
area shown at full resolution in the Image window. 

 

Subsampling Factor 

Image Box 

1. Place the mouse cursor inside the Image box, hold down the left mouse button, drag to the desired location, and 
release to reposition the portion of the image shown in the Image window. The Image window is updated 
automatically when the mouse button is released. 

2. Click anywhere within the Scroll window using the left mouse button to instantly move the selected Image 
window area. If you click, hold, and drag the left mouse button in this fashion, the Image window will be updated 
as you drag (the speed depends on your computer resources). 

3. Click in the Image box and press the arrow keys on your keyboard. To move the image in larger increments, hold 
down the Shift key while using the arrow keys. 

The Zoom Window 
The Zoom window shows a portion of the image magnified the number of times indicated by the number shown in 
parentheses in the Title Bar of the window. The zoom area is indicated by a highlighted box (the Zoom box) in the Image 
window. 

 

Zoom Level 

Zoom controls 

There are three Zoom controls (red by default) in the lower left corner of the Zoom window. These control the zoom 
factor and the crosshair cursor in both the Zoom and Image windows. 

1. Place the mouse cursor in the Zoom window and click the left mouse button to reposition the magnified area 
(displayed in the Zoom box in the Image window) by centering the zoomed area on the selected pixel. 

2. Click and hold the left mouse button in the Zoom window while dragging.  This causes the Zoom window to pan 
within the Image window. 
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3. Click the left mouse button on the  graphic in the lower left corner of the Zoom window to zoom out by a factor 

of 1. 

4. Using a three button mouse, click the middle mouse button on the  graphic to zoom out by a factor of 2. 

5. Click the right mouse button on the  graphic to return the Zoom window to the default zoom factor. 

6. Click the left mouse button on the  graphic to zoom in by a factor of 1. 

7. Click the middle mouse button on the  graphic to zoom in by a factor of 2. 

8. Click the right mouse button on the  graphic to return the Zoom window to the default zoom factor. 

9. Click the left mouse button on the  graphic to toggle the crosshair cursor in the Zoom window on or off. 

10. Click the middle mouse button on the  graphic to toggle the crosshair cursor in the Image window on or off. 

11. Click the right mouse button on the  graphic to toggle the Zoom box in the Image window on or off. 

12. The Zoom window can also have optional scroll bars, which provide an alternate method for moving through the 
Zoom window. Right-click in the Zoom window and select Toggle  Zoom Scroll Bars.  To have scroll bars 
appear on the Zoom window by default, use the ENVI main menu bar to select the File  Preferences  
Display Defaults tab.  Set the Zoom window Scroll Bars toggle to Yes. 

The Mouse Button Descriptions Dialog 
ENVI has many interactive functions, and the mouse button combinations and actions are different for each one. The 
Mouse Button Descriptions dialog is available to assist you in understanding what the mouse buttons do in each graphics 
window. Start the Mouse Button Descriptions dialog by performing either of these methods: 

• From the Display group menu bar, select Window  Mouse Button Descriptions. 

• From the ENVI main menu bar, select Window  Mouse Button Descriptions and place your cursor over the 
Image window. 

 
When the Mouse Button Descriptions dialog is open, the mouse button assignments for each ENVI display or graphics 
window are shown in the dialog when the cursor is poised over a display group window. In the dialog, MB1 is the left 
mouse button, MB2 is the middle mouse button, and MB3 is the right mouse button. 

Basic ENVI Functions 
This section of the tutorial takes you on a step-by-step tour of ENVI’s basic functions. 

Displaying the Cursor Location and Value 
You can choose to display the location of your mouse cursor, screen value (RGB color), and the actual data value of the 
pixel underneath the crosshair cursor using the Cursor Location/Value dialog.  When several display groups are open, this 
dialog specifies which display group’s location and value are being reported. 

1. To display the cursor location and value, select Window  Cursor Location/Value from either the ENVI main 
menu bar or the Display group menu bar.  You can also right-click in the Image window and select Cursor 
Location/Value. 

2. Move the mouse cursor over the Image, Scroll, or Zoom windows to display location and value information in the 
Cursor Location/Value dialog. 

3. Double-click in the Image window to hide the Cursor Location/Value dialog.  Double-click again to show the 
Cursor Location/Value dialog. 

4. From the Cursor Location/Value menu bar, select File  Cancel to close the dialog.  
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Displaying Image Profiles 
X (horizontal), Y (vertical), and Z (spectral) profile plots can be selected and displayed interactively. These profiles show 
the data values across an image line (X), column (Y), or spectral bands (Z).  To display these profiles, perform the 
following steps. 

1. From the Display group menu bar, select Tools  Profiles  X Profile to display a window plotting data values 
versus sample number for a selected line in the image. 

2. From the Display group menu bar, select Tools  Profiles  Y Profile to display a plot of data value versus 
line number. 

3. From the Display group menu bar, select Tools  Profiles  Z Profile to display a spectral plot.  You can also 
open a Z profile from the right-click menu in any Image window. 

4. From the Display group menu bar, select Window  Mouse Button Descriptions to view the descriptions of 
the mouse button actions in the Profile displays. 

5. A red crosshair extends to the top and bottom and to the sides of the Image window. The red lines indicate the 
line or sample locations for the vertical or horizontal profiles.  Move the crosshair around the image (just as you 
move the Zoom box) to see the three image profile plots update to display data on the new location. 

6. Close the profile plots by selecting File  Cancel from the menu bar within each window. 

Performing Quick Contrast Stretching 
You can perform quick contrast stretches using default parameters and data from either the Image window, the Zoom 
window, or the Scroll window. 

1. From the Display group menu bar, select Enhance and apply various contrast stretches (Linear, Linear 0-255, 
Linear 2%, Gaussian, Equalization, and Square Root). 

2. Compare the effects of the various stretches on the display group. 

Displaying Interactive Scatter Plots 
You can plot the data values of two selected image bands versus 
each other in a scatter plot to graphically display the overlapping 
values. 

1. From the Display group menu bar, select Tools  2D 
Scatter Plots.  The Scatter Plot Band Choice dialog 
appears, allowing you to choose the two image bands to 
compare. 

2. Select one band for the x axis and another band for the y 
axis and click OK. It may take a few seconds for ENVI to 
extract and tabulate the data values. 

3. Once the scatter plot has appeared (see image right), 
position the mouse cursor anywhere in the Image window 
and drag with the left mouse button pressed. Pixel values 
contained in a ten-pixel by ten-pixel box surrounding the 
crosshair will be highlighted in red on the scatter plot.  

4. From the Display group menu bar, select Window  
Mouse Button Descriptions to display the functions of 
the different mouse button actions when applied in the 
Scatter Plot display. 

5. Click and drag the cursor around in the Image window to observe the dancing pixels effect. 
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You can also use the scatter plot to highlight specific data values in the Image window. 

1. Place the mouse cursor in the Scatter Plot window and click and drag with the middle mouse button. Pixel values 
contained in a ten-pixel by ten-pixel box surrounding the crosshair will be highlighted in red on the scatter plot 
Pixels with the values contained in the box are highlighted in the Image window and appear to dance. 

2. From the Scatter Plot menu bar, select File  Cancel to close the Scatter Plot window. 

Loading a Color Image 
Previously, you opened and were working with Band 4 of can_tmr.img.  
You opened that image using the Gray Scale option.  Now you will open 
three bands of the image using the RGB Color option. 

1. If the Available Bands List dialog is not displayed, select Window  
Available Bands List from the ENVI main menu bar. 

2. Click the RGB Color radio button, then select TM Band 1 under 
can_tmr.img.  The band you have chosen is displayed in the field 
marked R. 

3. Select TM Band 2.  The band you have chosen is displayed in the 
field marked G. 

4. Select TM Band 5.  The band you have chosen is displayed in the 
field marked B. 

5. Click Display #1 and select New Display. 
6. Click Load RGB to load the image into a new display. 

Linking Two Displays 
Link the two displays together for comparison. When you link two displays, 
any action you perform on one display (scrolling, zooming, etc.) is echoed in 
the linked display. To link the two displays on your screen, do the following.  

1. From the Display group menu bar, select Tools  Link  Link 
Displays.  You can also right-click in the Image window and select 
Link Displays. 

2. Click OK in the Link Displays dialog to establish the link. 

3. Scroll and zoom in one display group and observe as your changes are mirrored in the second display. 

Dynamic Overlays 
ENVI’s multiple dynamic overlay feature allows you to dynamically superimpose parts of one or more linked images onto 
another image.  Dynamic overlays are turned on automatically when you link two displays, and may appear in either the 
Image window or the Zoom window. 

1. Click the left mouse button in one of the Image windows to see the image displays overlaid on one another. 

2. To create a smaller overlay area, position the mouse cursor anywhere in either Image window (or Zoom window) 
and hold down and drag with the middle mouse button. Upon button release, the smaller overlay area is set 
and a small portion of the linked image will be superimposed on the current Image window. 

3. Click the left mouse button in the Image window and drag the small overlay window around the image to see the 
overlay effects. 

4. Resize the overlay area at by clicking and dragging the middle mouse button until the overlay area is the desired 
size. 
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Selecting Regions of Interest 
ENVI lets you define regions of interest (ROIs) in your images. ROIs are typically used to extract statistics for 
classification, masking, and other operations. 

1. From the Display group menu bar, select Overlay  Region of Interest, or right-click in the Image window 
and select ROI Tool. 

2. Draw a polygon that represents the region of interest by clicking the left mouse button in the Image window to 
establish the first point of the ROI polygon, then selecting further border points in sequence by clicking the left 
button again.  Close the polygon by clicking the right mouse button, then accept the polygon by clicking the right 
mouse button again. The middle mouse button deletes the most recent point, or (if you have closed the polygon) 
the entire polygon. 

ROIs can also be defined in the Zoom and Scroll windows by selecting the appropriate window radio button in the 
ROI Tool dialog. 

When you have finished defining an ROI, it is shown 
in the dialog table, with the name, region color, 
number of pixels enclosed, and other ROI properties. 

ROIs can also be defined as polylines or as a 
collection of individual pixels by selecting the desired 
ROI type from the ROI_Type pull-down menu in the 
ROI Tool. 

3. Click the New Region button.  

4. Select an ROI by clicking in a cell of the far left 
column of the ROI Tool table. An ROI is selected 
when its entire row is highlighted. An asterisk next to 
the row also signifies the currently active ROI. 
Multiple ROIs can be selected by using Shift-click or 
Ctrl-click. All the ROIs can be selected by clicking the 
Select All button.  Click and type to edit the values 
in the cells of the ROI Tool table.  Change the name 
for the region and select a new color. 

5. Hide ROIs by selecting them in the table and clicking 
the Hide ROIs button. Use the Show ROIs button 
to re-display these hidden ROIs. 

6. Go to an ROI in the ENVI display by selecting it and clicking the Goto button. 

7. View the statistics for one or more ROIs by selecting them in the table and clicking the Stats button. 

8. Grow an ROI to its neighboring pixels within a specified threshold by selecting it and clicking the Grow button. 

9. Pixelate polygon and polyline ROIs by selecting them in the table and clicking the Pixel button. Pixelated objects 
become a collection of editable points. 

10. Delete ROIs by selecting them in the table and clicking the Delete button. 

The ROI Tool table also allows you to view and edit various ROI properties, such as name, color, and fill pattern.  
Menu options available at the top of the ROI Tool dialog let you perform other various tasks, such as calculate 
ROI means, save your ROI definitions, and load saved definitions.  ROI definitions are retained in memory after 
the ROI Tool dialog is closed, unless you explicitly delete them.  ROIs are available to other ENVI functions even 
if they are not displayed. 

11. Close the ROI Tool using the menu at the top of the table, select File  Cancel. 
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Annotating the Image 
ENVI’s flexible annotation features allow you to add text, polygons, color bars, and other symbols to your plots and 
images. 
 
The Annotation Text dialog allows you to choose from a variety 
of annotation types. Different types are selected from the 
Object menu and include Text, Symbols, Rectangles, Ellipses, 
Polygons, Polylines, Arrows, Map Scale Bars and Declination 
Diagrams, Map Keys, Color Table Ramps, and Images. By 
default, the Annotation dialog starts up with Text selected. Other 
fields in the dialog let you control the size, color, placement, and 
angle of the annotation text. When you select different 
annotation types from the Object menu, the fields in the dialog 
change to display options appropriate to the new type. 

1. From the Display group menu bar, select Overlay  
Annotation.  

2. Type some text in the text field of the Annotation Text 
dialog. 

3. Select a font, font size, and color using the fields 
provided in the dialog, then position the mouse pointer 
in the Image window and click the left mouse button. 
Your text is displayed in the window at the point you 
clicked. 

Remember, you can view the mouse button descriptions 
using the Display group menu bar Window  Mouse Button Descriptions option. 

4. Using the left mouse button, drag the handle (displayed in the image below as a diamond shape to the left, 
bottom of the text) to position the text in the window. 

 

5. You can continue to change the annotation’s properties and position by changing the fields in the dialog box or 
dragging the text or symbol while holding down the left mouse button. When you are satisfied with the 
annotation, click the right mouse button to fix the annotation in position. 

6. You can save your image annotation by selecting File  Save Annotation from the Annotation Text dialog 
menu bar.  If you do not save your annotation in a file, it will be lost when you close the Annotation Text dialog 
(you will be prompted to save the annotation if you close without first saving).  You can also restore saved 
annotation files by selecting File  Restore Annotation from the Annotation Text dialog menu bar. 
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7. To edit an annotation element that has already been set in the image, select Object  Selection/Edit from the 

Annotation Text dialog menu bar. 

8. Draw a box around the annotation you wish to edit by clicking and dragging with the left mouse button.  When 
the handle reappears, click and drag the handle and annotation to move and configure the item just as you would 
a new annotation. 

9. To suspend annotation operations and return to normal ENVI functionality temporarily, select the Off radio 
button at the top of the Annotation Text dialog. This allows you to use the scroll and zoom features in your 
display without losing your annotations.  To return to the annotation function, select the radio button in the 
Annotation Text dialog for the window you are annotating. 

10. Leave your annotation on the Image window as you complete this tutorial. 

Adding Grid Lines 
You can use grid lines to overlay one or more grids on an image. Grids can be pixel-based or map-coordinate and/or 
latitude/longitude based (for georeferenced images). Each image display can have its own set of grids, which are 
displayed in the Image, Scroll, and Zoom windows. 

1. From the Display group menu bar, select Overlay  Grid Lines to open the Grid Line Parameters dialog box.  
As soon as you choose this option, an image border is automatically added. 

2. You can adjust the grid line attributes by setting the line thickness and color and the grid spacing by selecting 
Options  Edit Pixel Grid Attributes from the Grid Lines Parameters dialog menu bar. This selection brings 
up the Edit Pixel Attributes dialog box. 

3. In the Edit Pixel Attributes dialog, you can change the color, thickness and grid spacing for the labels, lines, box 
and corners of the grid. When the attributes are set up to your satisfaction, click OK in the Edit Pixel Attributes 
dialog to apply the changes to the grid on the images. 

4. When you have added a satisfactory grid, click Apply in the Grid Line Parameters dialog. 

 

Saving and Outputting an Image 
ENVI gives you several options for saving and outputting your filtered, annotated, gridded images. You can save your 
work in ENVI’s image file format, or in several popular graphics formats (including Postscript) for printing or importing 
into other software packages. You can also output directly to a printer. 

1. From the Display group menu bar, select File  Save Image As  Image File to save your work in ENVI’s 
native format (as an RGB file). The Output Display to Image File dialog appears. 
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2. Select 24-Bit Color or 8-bit (gray scale) output. 

3. Click the Change Graphic Overlay Selections button to select graphics options (including annotation and 
gridlines) 

4. Set border options. 

5. Select output to Memory or File using the desired radio button. If output to File is selected, enter an output 
filename. 

6. If you select other graphics file formats from the Output File Type drop-down which, by default is set to ENVI, 
your choices will be slightly different. 

7. Click OK to save the image. This process saves the current display values for the image, not the actual data 
values. 

Exiting ENVI 
End the ENVI session by selecting File  Exit from the ENVI main menu, then click OK to terminate ENVI when 
prompted. 
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